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Introduction to The Payroll SiteIntroduction to The Payroll Site

Legislative updatesLegislative updates

The Payroll Site is kept up to date with all the relevant changes to

legislation, which you automatically benefit from when you log on to

www.thepayrollsite.co.uk.

HelpHelp

This guide will help you to use the system. Also, once you have logged

onto the website, you will see, every time you click on a field, a handy

help box, situated to the bottom left of the screen. This will help you

with what to enter on the screen. Please note that if you are using a

mobile device, the position of this box may differ. You will also find

useful guides and FAQs within the website to assist you further. In

addition, you can find our contact details on the 'Contact Us' page of

the website.

Security of dataSecurity of data

All customer information is kept securely on computer systems located

in the UK, in compliance with the Data Protection Act. This service is

provided using 128-bit encryption and digital certificates to ensure that

all communications are secure. Duplicate systems are kept in data

centres at separate locations, to minimise disruption in the event of a

major catastrophe.

PricingPricing

For current pricing information, please see our website

www.thepayrollsite.co.uk
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Entering company detailsEntering company details

Click onto 'Employer' under the options menu where you will be asked

for the following information:

Employer Name and Address

Enter the name and address of the organisation or person who is the

employer.

Employer's PAYE Reference

The first box is for the 3 digit code of your HMRC PAYE office and the

second is for the PAYE reference. These two numbers are grouped

together on the front of the HMRC booklet P30BC or on the letter P30B

'Paying electronically'.

Employer's Accounts Office Reference

This reference is issued by HMRC and is not the same as the PAYE

reference. You can find it on your payslip booklet, or on other HMRC

correspondence. It is 13 characters, starting with 3 digits and then 2

letters.

HMRC User ID

This is the User ID you were given when you signed up for HM Revenue

& Customs online.

Corporation Tax Ref or Self Assessment UTR

You should only have one of these, depending on your business

structure. If one of these references is supplied, it will be included in

your Real Time Information submissions.

AE Duties Start / Staging Date

You can look this up on The Pension Regulator's website if you are not

sure.

Re-enrolment Date

Enter your next re-enrolment date here. Re-enrolment is required every

3 years.

Tax Payment Frequency

This will be set to monthly unless you have an arrangement with HMRC

to pay quarterly.
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Entitled to £xxxx Employment Allowance?

You should select either Yes, if you are eligible, or No, if you are not.

More information about eligibility can be found on HMRC's website.

Once you have made the selection, you should follow the onscreen

instructions to inform HMRC.

Apprenticeship Levy Applies?

You should select Yes if this applies to you. More information is

available in the Help box.

Apprenticeship Levy Allowance

If you have indicated that the Apprenticeship Levy applies to you, then

this field will automatically default to the full allowance. If the employer

is connected with other employers, the allowance should be changed

and divided between all parties.

Was the total NI liability (including employee's contributions) less than

£45,000?

This information will enable the system to determine if you are entitled

to reclaim a higher proportion of Statutory Pay for Parents.

If you wish to edit your company's details, click on 'Edit Changes', make

the required amendments, and then click 'Save Changes'.
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Setting up employeesSetting up employees

Adding an employee / new starterAdding an employee / new starter

Click on 'Add Employee', which is under the 'Options' menu to the left

of the page. You will then see this screen.

Choose the relevant option and then follow the onscreen instructions.

If starter information needs to be sent to HMRC, this will be attached

to your next Full Payment Submission (FPS).
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You will then see a screen similar to the one below. The look of the

screen depends on which option you have selected.

Enter all of the employee's details. When you click on any field, the help

box, situated to the bottom left of the page, will automatically change

to give you guidance relating to that field. When you have finished

entering the details, click 'Create Employee'.

If you are transferring data from another

payroll system, then you must ensure

that you use the same Payroll ID

(referred to as Employee Ref No) on our

site. If you have an employee who leaves

your employment but then comes back

you must use a different Payroll ID.

5



Once you have added your employee, you should then click on their

name on the left hand side of the screen. You will then be able to

complete any additional information using the tabs 'Personal Details',

'Payslip Items' and 'Tax Details'. If you are adding or changing

information, then you will need to click 'Edit Details' and once finished,

'Save Changes'. The other three tabs are explained later in this guide.

LeaversLeavers

When an employee leaves

Step 1 - Go to their Tax Details tab and enter their Leaving Date

and Final Pay Date (this date should match the date of their final

payment).

Step 2 - Enter the pay run covering their final wages, ensuring the

Pay Date matches the Final Pay Date.

Step 3 - Once confirmed, this will trigger the system into sending

their Leaving Date to HMRC when you send your next Full

Payment Submission.

Step 4 - Return to their Tax Details tab. Here you will be able to

click and 'create' the P45. Once you have checked it, click 'Confirm'

and then give a copy of the plain paper P45 to the leaver, either

electronically, or by printing it.

You do not need to send a copy of the P45 to HMRC.

Deleting an employeeDeleting an employee

If you have entered an employee in error, then you can delete them.

Under the 'Personal Details' tab, for each employee, there is an option

to 'Delete Employee'. If, however, they have been paid within the tax

year, you should NOT delete them.

If you set someone up as a 'Company

Director', the National Insurance is

calculated in a different way. If you are

unsure about who should be treated as

a director, or which method to use, see

HMRC Helpbook CA44.
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Paying employeesPaying employees

Step 1 - Click on 'Pay Employees', which is under the options

menu to the left on the screen.

Step 2 - Click on 'Start New Pay Run'.

If you are switching payroll systems, and

any of your employees has been paid in

the current tax year (from 6th April)

using another system, then you will need

to enter details of the wages, tax & NI.

To do this, follow the steps below but

remember that you will need to enter

each pay run to bring them up to date.
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Step 3 - Set the Pay Date, Salary (if not already shown) and other

columns as necessary. You can also click on 'Add' under the 'Extra

Options' column for more pay options, such as Deductions from

Net Pay or Hourly Pay. When you click on any field the help box

situated to the bottom left of the screen will automatically change

to give you guidance on filling in that field. If you wish to pre-set

any reoccurring additional payments or hourly pay rates, this can

be done on the 'Payslip Items' tab for that employee, prior to

starting the payrun.

Step 4 - Click 'Calculate Deductions' and you will see a screen like

this.

Step 5 - Check that the information looks correct and then click

'Confirm Payments'.

Step 6 - You now have the option to View / Print payslips. If you

prefer to email them to your staff, then click the 'Payslip Options'

tab.

Step 7 - Click onto the RTI Submission tab.
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Sending Real Time Information to HMRCSending Real Time Information to HMRC

Every time you do a pay run for your staff, you will be required to send

a Full Payment Submission (FPS). To do this, follow the steps below:

Step 1 - In the 'RTI Submission' tab, click on 'Create RTI

Submission'.

Step 2 - The system will then create an FPS, which you can view

on screen. It will automatically include details of the current pay

run and totals for the tax year to date.

Step 3 - Fill in your User ID and Password for the HMRC Online

Gateway and click 'Send to HMRC'.
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TroubleshootingTroubleshooting

My employee's tax figures don't look right

There are two HMRC approved methods for calculating PAYE

income tax, and depending on the method used, the result can

differ by up to 2p. The Payroll Site uses the computerised method.

If the employee is new or the earnings are too low there may be

no tax as yet.

There may be a tax rebate for a new employee.

If you haven't entered history of past pay, the figures may be

wrong.

Reason for no NI figure

If the employee is a Company Director, the NI is calculated over a

longer period - typically a year. This often leads to zero NI in the

first few periods of the year and, then, higher figures later on in

the year.

The NIC table letter is set to C or X. I.e. if the employee is under 16

or over the retirement age.

The pay is too low to attract NI.

I have confirmed the pay run but now realise it is wrong

If you have not already made a tax payment, you can delete the last

pay run. To do this, follow these steps:

Step 1 - Click on the name of the employee on the left of the

screen under 'Options'.

Step 2 - Click on the 'Working Sheet' tab, which is the last tab on

the right.

Step 3 - Click on the 'Delete Last Payment' button at the bottom

of the page.

Step 4 - Go back to 'Pay Employees' and re-run the payrun that

you have deleted. Ensure that you use the same pay date that

was used prior to deletion. Once confirmed, send the RTI to

HMRC. Our system will carry over the amendment.

10



There is no 'Start New Pay Run' button

This is because the previous pay run you entered was never confirmed.

Click on the button 'Confirm Payments', 'Change Payments' or 'Discard

Pay Run'. You will then be able to 'Start New Pay Run'.

An employee has left but is still appearing

There are 2 reasons for this, so you need to check the following:

Have you entered the 'Leaving Date' for the employee on their

'Tax Details' page? If not, please do so.

Ensure that the Final Pay Date entered on the Tax Details tab

matches the actual date you are paying the employee for the final

time.

I need to pay my employee for a partial month

The way pay is calculated for partial months (or partial weeks) is

determined by the contract between employer and the employee. If no

arrangement has been agreed, the default arrangement it is to divide

the annual salary by 365 and then multiply by the number of calendar

days.

If you have already saved a tax

payment, you can delete it from the

'HMRC Payments' page. Don't forget to

make a note of the amount you paid to

HMRC before you click 'delete'.

There are actually 52 weeks and 1 day in a

year, or 52 weeks and 2 days in a leap year. If

an employee is paid weekly and one of their

pay dates falls on the extra day or days, it will

be classed as week 53. If they are paid

fortnightly then that payment will be classed

as week 54. Finally, if they are paid four

weekly, then the last payment will be classed

as week 56.
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Exporting to your accounting systemExporting to your accounting system

After you have clicked 'Confirm Payments', click on the 'Export to

Accounting' button. Within the configuration page you have the

following options:

CSV

The figures can be exported as a CSV file, which can then be loaded

into a spreadsheet and imported into some accounting systems.

FreeAgent API

If you have an account with FreeAgent you can transfer your payroll

figures directly into their system. For more information, please see the

FAQ within the website 'How do I export my pay run figures to

FreeAgent?'

KashFlow API

If you have an account with KashFlow you can send your payroll figures

directly to their system. For more information, see the FAQ within the

website 'How to I export my pay run figures to KashFlow?'

QuickBooks Online

If you have an account with QuickBooks Online you can send your

payroll figures directly to their system. For more information, see the

FAQ within the website 'How do I export my pay run figures to

QuickBooks Online?'

QuickFile

If you have an account with QuickFile you can send your payroll figures

directly to their system. For more information, see the FAQ within the

website 'How do I export my pay run figures to QuickFile?'

Sage One

If you have an account with Sage One you can transfer your payroll

figures directly to their system. For more information, see the FAQ

within the website 'How do I export my pay run figures to Sage One?'

Sage 50 CSV / Old Sage 50

If you use Sage 50 Accounts 2010 onwards, you can use the Sage 50

CSV option to transfer your figures into your accounting system. The

Old Sage 50 option can be used with earlier versions of Sage 50. For

more information, please see the FAQ within the website 'How do I

export my pay run figures to Sage?'
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Xero Journal or Bill API / CSV

If you have an account with Xero, you can transfer your payroll figures

directly into their system, or you can transfer them indirectly using a

CSV file. For more information, please see the FAQ within the website

'How do I export my pay run figures to Xero?'

Business Accountz

Accountz.com Ltd publishes this package and incorporates a feature

for downloading your payroll figures directly from The Payroll Site.

To use this feature, open Business Accountz, click on the File menu and

choose the Payroll option. Detailed help about using this feature can

then be viewed by clicking on the '?' symbol in the bottom corner of

that page.
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Calculating sick payCalculating sick pay

Understanding sick payUnderstanding sick pay

Below is a list of key terms, which are used when referring to Statutory

Sick Pay (SSP).

PIWPIW : Period of Incapacity for Work for 4 or more continuous sick days

(PIWs can be linked)

QDQD : Qualifying Day

WDWD : Waiting Day

Statutory Sick Pay is paid to employees who are unable to work

because of illness and who meet the criteria below:

1. The employee must be sick for a minimum of 4 days. All days, not

just scheduled work days, count towards a PIW (Period of

Incapacity to Work).

2. Their earnings must be at least as much as the Lower Earnings

Limit for National Insurance Contributions.

3. The employee must have notified you of their sickness - either

within your own set time limit or within seven days.

4. The employee has not already received the maximum amount of

SSP.

If your employee is not entitled to SSP then you, the employer, should

complete an SSP1 form and give it to the employee, as they may be

able to claim a social security benefit.

Entering sick days onto the systemEntering sick days onto the system

Step 1 - Click on the employee's name.

Step 2 - Click on the 'Statutory Pay' tab.

Step 3 - Under 'Statutory Sick Pay', the automatic default for 'Add

Statutory Sick Pay to Wages' is set to 'Yes'. This should be left as

'Yes' if the employee is only to receive the statutory minimum

while off sick. If you are paying full wages, change it to 'No'.

Step 4 - Under 'List of Sick Periods', enter the first full day that the

employee was sick.

Step 5 - Enter the last full day of their sickness. If the sickness is

ongoing, then leave this blank and go back to enter it once they

have returned to work.
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Step 6 - Click 'Add'. You will then see the average earnings for the

relevant set period. The SSP amount at this point will still show as

0.00.

Paying an employee with sick payPaying an employee with sick pay

First, begin the pay run as normal by clicking on 'Pay Employees' and

then clicking 'Start New Pay Run'.

If you are paying the employee just the statutory minimum, you will

need to reduce the salary to reflect the amount they should be paid for

the time they actually worked (see the 'I need to pay my employee for a

partial month' section on Page 9). The system will add the SSP at a

later step.

Next, click on the 'Sick Pay' button and you will see the following

screen.

You are now being asked to enter the qualifying days - remember,

unless otherwise agreed, these are the days the employee normally

works. So, if the employee normally works Monday to Friday, you

should untick Saturday and Sunday.

If the employee does not follow a set weekly working pattern then click

where indicated, underneath the grid. You should then untick all of the

days that are not normally worked.
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Below the qualifying days, you are asked if any exclusions apply. Please

click on the relevant option and enter the date from which the

exclusion applies, where prompted. If there are no exclusions, then

leave as 'None of the above apply'.

Click 'Calculate Sick Pay'.

You will then be shown how the SSP is to be worked out and the

amount.

You can now click 'Calculate Deductions' and proceed as normal.
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Calculating statutory pay for parentsCalculating statutory pay for parents

Who qualif ies for Statutory Maternity Pay?Who qualif ies for Statutory Maternity Pay?

An employee who meets the criteria below is entitled to Statutory

Maternity Pay (SMP).

1. She must have worked continuously - full or part-time - for at

least 26 weeks up to and into the 15th week before the week the

baby is due.

2. Her earnings must be equal to or exceed the Lower Earnings Limit

for National Insurance Contributions.

3. She must have given the employer the correct paperwork

confirming the pregnancy and sufficient notice of when she would

like the SMP payments to begin.

The system will check these criteria for you if you click the 'Use Wizard'

button on the Statutory Pay tab.

If your employee is not entitled to SMP, then you, the employer, should

complete an SMP1 form and give it to the employee, as they may be

able to claim maternity allowance instead.

Who qualif ies for Statutory Paternity Pay?Who qualif ies for Statutory Paternity Pay?

An employee who meets the criteria below is entitled to SPP.

1. They have worked for you continuously for at least 26 weeks up to

and into the 15th week before the date the baby is due.

2. They continue to work for you until the date the baby is born.

3. Their earnings must be equal to or exceed the Lower Earnings

Limit for National Insurance Contributions.

If the child is adopted, the rules are slightly different. You can get these

rules from the HMRC.

Entering statutory leave onto the systemEntering statutory leave onto the system

Step 1 - Click on the employee's name.

Step 2 - Click on the 'Statutory Pay' tab.

Step 3 - Under 'Statutory Pay for Parents', the automatic default

for 'Add to Wages' is set to 'Yes'. This should be left as 'Yes' if the

employee is only to receive the statutory minimum whilst off. If

you are paying full wages, change it to 'No'.
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Step 4 - Click the 'Use Wizard' button and answer the questions

as they come up.

Step 5 - When you have answered all of the questions, you will be

asked to save. At this point click the 'Save' button.

Paying statutory pay for parentsPaying statutory pay for parents

First, begin the pay run as normal by clicking on 'Pay Employees' and

'Start New Pay Run'.

If you have set 'Add to Wages' as 'Yes' then you will need to reduce the

salary amount to reflect the time they actually worked in this pay

period For the majority of the paid leave, this would be set to 0.00.

Once you have done this, click 'Save'.

If you have set 'Add to Wages' as 'No', then you do not need to reduce

the salary. You can now continue with the pay run as normal.
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Recovering statutory pay for parentsRecovering statutory pay for parents

Any amount that can be reclaimed will be worked out automatically

and shown on the 'HMRC Payments' page.

If you are recovering statutory pay, then you will also need to send an

Employer Payment Summary to HMRC. Please see the 'Employer

Payment Summary (EPS)' section for how to do this.
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Entering other deductionsEntering other deductions

PensionsPensions

For more information about how our site deals with Auto-Enrolment /

Workplace Pensions please see our online guides, which can be found

by clicking on the 'Help and Guides' option.

Attachment OrdersAttachment Orders

If you are required to deduct any court order or child support payments

from your employee's wages, then these can be entered at the bottom

of the 'Payslip Items' page. There is an 'Overview of Order Types' on

this screen, which will provide you with an explanation of each order.

Once you have clicked on the correct order type from the drop down

box, you should click 'Add Order'. You will then be asked to enter the

relevant figures. Now, click 'Save Changes'. Once you have entered all

of the required information relating to the order, the figures will

automatically be calculated and shown when you do any subsequent

pay runs.

Student loansStudent loans

If you are informed that an employee should be having a student loan

deducted from their salary, then you will need to know whether it is

Plan 1 or Plan 2. You can then set this by going to their 'Tax Details'

tab and changing the 'Student Loan Deductions' question to reflect

either Plan 1 or Plan 2. The system will then do all the calculations for

you when doing your pay run.
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Paying HM Revenue & CustomsPaying HM Revenue & Customs

Saving tax paymentsSaving tax payments

Step 1 - Click onto 'HMRC Payments / EPS', which you will find

under the 'Options' menu on the left of the screen.

Step 2 - Click onto the field 'Enter Date Paid' and enter the date

you have paid, or are planning to pay, HMRC. Then click 'Save'.

Step 3 - Repeat this step each month or each quarter to help

ensure your payments are up to date.

You need to make monthly payments to

HMRC unless you have arranged with them

to pay quarterly. The payments are due by

the 19th of the month, or the 22nd if you pay

electronically.

21



Adding special itemsAdding special items

It is on this page that you can add any special items such as CIS

deductions. To do this:

Step 1 - Click on 'Add a special item'.

Step 2 - Select the special item from the drop down menu.

Step 3 - Enter the amount and click 'Add'.

You will see what you have just added on the main screen above.

You now have a record of the figures and when payments were made

to HMRC.

If you wish, you can also print this information by clicking on the 'Print

This Page' button located at the bottom of the screen.

Employer Payment Summary (EPS)Employer Payment Summary (EPS)

If you have any parental pay or CIS deductions to reclaim from HMRC,

then you will be required to send an Employer Payment Summary to

HMRC. This option can be found on the second tab within the 'HMRC

Payments / EPS' option. You should select the 'Amounts to Reclaim'

option and then click 'Create EPS Submission'.

You can set up an automated 'tax reminder'

email in the 'Preferences' section.

Always check that employee payments

have been confirmed before saving a tax

payment.
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You will see the following screen:

The system will automatically fill in the figures for how much can be

reclaimed. This information is taken from the completed pay runs and

does not need to be entered manually. It will also take into account

any CIS deductions suffered if you have entered these as special items

on the HMRC Payments page. Once you are ready to send the

information to HMRC, fill in your User ID and Password for HMRC

Online and click 'Send to HMRC'.

An EPS submission should reach HMRC by the 19th of the month.

Informing HMRC that no employees are being paid inInforming HMRC that no employees are being paid in

a certain tax montha certain tax month

If no employees are being paid in a certain tax month, you must let

HMRC know by sending a 'No Payments Made' EPS. This can be done

by following the instructions above; but, instead of choosing the option

for 'Amounts to Reclaim', you should choose 'No Payments Made'.
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Viewing working sheetsViewing working sheets

The 'Working Sheet' tab, which can be found by clicking on the

employee's name under the 'Options' menu on the left of the screen,

shows the pay and deductions for an employee over the tax year so far.

It is similar in layout to the HM Revenue & Customs P11 form.

The 'Working Sheet' is split into 3 main column headings:

National Insurance Contributions

Statutory payments

PAYE Income Tax

If you have made an incorrect payment to an employee (see the

'Paying employees' section), then you can delete the payment by

clicking on 'Delete Last Payment', which is at the bottom of the screen.

You also have the option of viewing old payslips, by clicking on the net

pay figure on the right side of the page.

PrintingPrinting

You can print the working sheet by clicking on 'Print Worksheet', which

is at the bottom of the screen. Alternatively, if you wish to print all

employees' working sheets then click on 'Reports', which is under the

'Options' menu on the left. You will then be able to click on 'Summary

pack' and print from there.

The summary pack can also be saved to your

computer or emailed if necessary. If you use

an accountant, the summary pack will

contain all the information that they would

need.
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Understanding the year end processUnderstanding the year end process

The tax year ends on 5th April and all pay dates after this must be

treated separately. You should check that the details of the old year are

complete before moving into the new year. You will have the option of

sending your final RTI submission to HM Revenue & Customs.

Finishing the tax yearFinishing the tax year

Whether you are planning to submit your final EPS, via The Payroll Site

or not, you will need to click 'Finish Tax Year'.

Before you do this, check to ensure the following has been completed:

1. All employees have been paid up to date and details sent to

HMRC.

2. All leavers have been processed.

Once you are satisfied that everything is up to date, then click on

'Finish Tax Year', which is under the 'Options' menu to the left of the

screen.

Final RTI SubmissionFinal RTI Submission

If you are not planning to send your final RTI submission via The

Payroll Site then you are now ready to proceed with paying your

employees in the new year.

Once you have clicked 'Finish Tax Year',

you will not be able to go back to make

any changes.
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If you are planning to submit your final RTI submission via The Payroll

Site and you are in a position to do this now, then you need to click on

'View Tax Year 20xx/xx' under the 'Options' menu. You will then see this

screen:

Figures for parental pay and CIS deductions reclaimed will appear

automatically, based on what you have entered onto the system. They

can be edited if necessary. Fill in your User ID and Password for HMRC

Online and click 'Send to HMRC'. You must send your final RTI

submission to HMRC by 19th April.

You should give P60 certificates to your employees by 31st May. You

can print or download a P60 by clicking the employee's name and then

the 'P60 Certificate of Pay' tab.

Remember, it is your responsibility, as an

employer, to ensure that the final RTI

submission is correct and submitted on

time.
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Further help & informationFurther help & information

If you need further help and information, the following options are

available to you within the website:

FAQFAQ

This is a list of frequently asked questions and can be found under the

'Options' menu on the website.

Help boxHelp box

Help will appear whenever you click on a field within the website, and

can be seen to the bottom left of the screen. Please note that if you are

using a mobile device, the position of this box may differ.

Contact usContact us

Details can be found on the 'Contact Us' page on the website.
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PreferencesPreferences

Click 'Preferences' under the options menu.

From this page, you can:

Change your password or your email address.

Validate your email address.

Fill in your contact details.

Set up automatic tax reminder emails.

Change the order that employees appear.

Close your account or make it dormant.

Change the payslip printing option.
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